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Part 1: In Theory

Getting Data from ESO:
- the contents of the ESO Science Archive Facility (SAF)
- how to access the archive for high-level science data or for raw data

Using Data from ESO:
- Reflex workflows and ESO pipelines
- Reflex workflow basics
- Installing Reflex
- a summary of the main features of Reflex

Part 2: In Practise

A Practical Demonstration

- retrieving raw data from the ESO archive

- retrieving science products from the ESO archive
- of the HAWK-I| Reflex workflow
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The ESO Archive

The ESO Science Archive Facility (SAF):
==> the operational and technical data archive for the La Silla Paranal Observatory

(serving 3 + 4 + 2 telescopes and 6 + 12 + 2 instruments)

Data Content (both raw and data products):
~ 500 TB of data consisting of 25 million files (~23 billion database rows of searchable header keywords)

Data Inflow:
~12 TB/month

Data Outflow:
~15 TB/month
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RAW data from the La Silla Paranal Observatory:
==> science, calibration, and technical data

Pipeline products:
mainly science products + ancillary data (standards, catalogues, error maps, etc.)

Two primary sources:

1. products generated at ESO by running the instrument data reduction pipelines with the standard calibration plan
- these are products that are not tailored to a specific science case, and can be processed further
2. products returned by the community through Phase 3
- tailored to the science cases of the programmes they originated from (Public surveys, Large Programmes, etc.)
- include highly processed data (tiles, stacks, catalogues)
- includes valuable historical data sets (e.g. GOODS, zCOSMQS, .. .)
- well-documented to summarize the characteristics and limitations of the data

Both are homogeneously accessible through the same archive interface to allow queries on the science and not the data origin
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1. Pipeline products:

many products available since the beginning of science operations

Currently available:
UVES, X-Shooter, HARPS, FLAMES-GIRAFFE

Soon to be available:
HAWK-I, VIMOS (imaging), MUSE, KMOS, and PIONEER

ESO/IAU-Opticon Summer School 2015



Archive Contents

2. Public Survey products:

- Third public data release of the 6 VISTA public surveys: VIDEO, , , , UltraVISTA, and
- Second public data release of the 3 VST public surveys: KiDS, , and

- Second data release from the 2 public spectroscopic surveys: Gaia-ESO and PESSTO

- 2 surveys with VIMOS just beginning: VANDELS and LEGA-C

B VHS B ATLAS u Vv B VPHAS+
B VIKING UltraVISTA B KIDS VIDEO
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sky coverage of ESO public surveys (southern hemisphere & full sky) ESO/IAU-Opticon Summer School 2015
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2. Public Survey products:
e.g. second public data release of the UltraVISTA B

L Kb L

B om UltraVISTA (


http://home.strw.leidenuniv.nl/~ultravista/

Archive Starting Point

archive.eso.org

1.

create your account on the ESO User Portal
(not needed for browsing, but for downloads)

access RAW data

or, access phase 3 data products
(images and spectra)

or, specific phase 3 catalogues

Welcome to the ESO Science Archive Facility

The ESO Science Archive Facility contains data from ESO telescopes at La Silla Paranal Observatory, including the APEX submillimeter telescope on Llano de Chajnantor. In addition,

the raw UKIDSS/WFCAM data obtained at the UK Infrared Telescope facility in Hawaii are available.

The Principal Investigators of successful proposals for time on ESO telescopes have exclusive access to their scientific data for the duration of a proprietary period, normally of one

year, after which the data becomes available to the community at large. Please read the ESO Data Access Policy

Browsing the archive does not require authentication, but to request and download data you have to log in fo the ESO User Portal. Plegise acknowledge the use of archive data in any

publication.

Latest News and Updates

ar more information, along with the relevant FAQs.

e New Release of PESSTO public survey data (06 Aug 2015)

e First release of the band merged catalogue for the VST Photometric H-alpha Survey of the Southern Galactic Plane (VPHAS+) (30 Jul 2015)
¢ New Release of Gaia-ESO Spectroscopic Public Survey Data (22 Jul 2015)

More news ...

To browse the archive
Currently, raw data and various types of data products can be reached via different interfaces:

D All ESO raw data Various Many La Silla Paranal instruments
ata -
............. Dirgerretreval of raw data by file name
LPO Data / Various
Products hase 3 main query form Phase 3 Data Products (ESO public Currentl
Phase 3 imaging query form surveys; ESO pipeline-reduced products; i yz:md Pipeline products for UVES,
Phase 3 spectral query form Large programs: GOODS, zCOSMOS; Spegctrgscopy XSHOOTER, HARPS, and more to
[Description ase 3 VIRCAM-specific query for etc.) come.
of reduced
data 7
products Phase 3 Catalogues [ESO User Portal
types] Catalogue Facllity query interface authentication required also when Catalogues Various
yp browsing]
\a'mmmn/ . . FEROS, HARPS-Polarimetry, HARPS
FEROS an metry pipeline FEROS and HARPS-Polarimetry pipeline belipaliles -
processed data query form processed data SREEIIT ':::SO:: a(f(l,l‘tl)gtlons itz iss
o _ Spectroscopy | FEROS
Other Advanced Data Products (available only - B
as downloadable packages, no query form) Various (30 Doradus, Corot, GaBoDs, etc.) Ig:laxgmgps XVFI:éx
Science Verification, Commissioning, EIS, etc. . . :
(no query form) Full list of available data packages Various Many
APEX Quick
APEX query form APEX hewerodyne: | APEX-2A, LABOCA, SABOCA, SHeF!
: ) ESO Observing Programme Information All La Silla Paranal instruments, including
Scheduling query form and Scheduling APEX
B+ ALMA Science Archive All ALMA data Cube ALMA

ESO/IAU-Opticon Summer School 2015



http://archive.eso.org

Access to RAW data

Availability of raw data (Paranal — Garching transter):

Data transfer Paranal-Garching, June 2014 50% within Zomin
o 90% within 30min
) 98% within 1hou:
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http://archive.eso.org/eso/eso_archive_main.html

ESO Archive Query Form
ESO Archive Overview Help Page FAQ

Instrument & Mode

((ins_id like 'FORS2%' AND dp_tech like 'IMA%'))

A
To search through the raw frames querying for instrument-specific parameters, please use the instrument-dedicated query forms. To search for reduced Data Products, including public surveys and pipeline-
reduced and quality-controlled science-ready data, please have a look at the generic data products query form. A list of other non-searchable advanced data products is available.
The checkboxes on the right of the parameters define whether or not they will be displayed on the query result page. o u t p ut p refe re n ce S
- | Reset Output preferences: | html table ™ Return max 200 rows. | All Fields | Syntax Help
v
n L] -
Target Name & NGC4039 | Resolved by SIMBAD  # | Night [ (YYYY MM(M) DD) A SearCh Crlterla . ’[al’g et name
Otherwi. [ ing the following start/end dates:
RA DEC J2000 ise give a query range using the following start/e es R A’ D EC
Search Box 00 10 00 Input | RA(h) DEC(deg)  + | Start [ 12hrs(uT] ¢ | End | 12hrs [UT] + ] . | ‘aht
Output # | Sexagesimal (h, deg) * | P_LOgl_:;‘mLD_@ Program Type (| |Any %) SI ng e n I g
PI Col [ SV (1 [Ay 3] range of nigh’[s
List of Targets | Choose File | no file selected Title [ )
— v programme D
Pl name
Imaging Spectroscopy Interferometry Other
| ALL | [ NONE | | ALL | [ NONE | | ALL | [ NONE | [ ALL | [ NONE | A
[JEFOSC2/LaSila [ 1|CES/LaSilla CJAMBERVLTI  [JBOL/APEX — DataProduct Info
[JEMMI/LaSilla [JCRIRESNVLT [ JMIDINVLTI [JHET/APEX Type & [omECT :
[(JFORSANLT [(JEFOSC2/LaSilla [JPIONIERNVLTI  [(JLGSFNLT . FE—
VFORS2VLT (JEMMILLaSila [ VINCIVLTI JMADNLT User defined input.
(JHAWKINVLT (JEEROS/LaSilla [ IMASCOT/Paranal Mode & | Any -
[JGROND/LaSilla [(JEORSANLT _ Polgrfmetry ‘ [ JWECAM/UKIRT User defined input:
[1ISAACNLT [JFORS2NLT | ALL | | NONE | Dataset ID
(INACONLT (JGIRAFFENLT LEJEFOSC'L’/LaSiIIa Category & Orig Name [
[JOMEGACAM/VST [ JHARPS/LaSilla [ JEORSINVLT Release Date
[ ISOFI/LaSilla (JISAACNLT (JEORS2VLT MSCIENCE - i ifi i i
S T v AL OB Name instrument specific criteria
(]SUSI/2/LaSilla MUSENLT ([ INACONLT " JACQUISITION OBID ()
CTIMMI2/LaSila | NACONLT |_|SOFI/LaSilla Instrumental Setup
[ VIMOSNLT SINFONIVLT | JSPHERENLT Exptime &
EJVIRCAMNISTA [ )SOFl/LaSilla P Filter &
CIVISIRNVLT (JSPHERENLT ~_oronagrapy -
[_JWFl/LaSilla [ TIMMI2/LaSilla | ALL | | NONE | Lrism |
JUVESNLT L:J EFOSC2/LaSilla Grating ()
Cvimosnir  JNACOMLT Slit [
CVISIRVLT ((JSPHERENLT
[(JXSHOOTER/NLT
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ESO Archive Query Results

+ ESO Archive Overview Help Page FAQ
To request data please select the datasets in the results table by marking the checkbox in the left-most column, then press the the Request marked datasets button.
(You will be prompted for your ESO User Portal username and password. If you do not yet have an ESO User Portal account, please fill out the registration form.)
Datasets for which the proprietary period is over are highlighted in green and are publicly available.
Datasets that are still under the proprietary period are highlighted in red and can only be downloaded by the corresponding PI.
Datasets that are not yet available in the Archive are marked with a "N/A™.
SIMBAD coordinates for NGC4039 : 1201 53.7, -18 53 08.0.
Reguest marked datasets | Reset ~MarkAll | | MarkPublic | | MarkProgrietary New query | | Programmatic | | Your Requests | I
& More | HDR OBJECT Target Ra, Dec Program_ID | Instrument | Category | Type Mode Dataset ID Release Date || Exptime Filter -OBS | Airmass Ambient
H Header | H-04GT_BVRI | 12:01:50.37 -18:53:32.7 || 075.D-0662(B) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2005-05-24T03:22:03.370 | May 24 2006 1.998 | B_BESS 53514.140317 1.281 || DIMM Seeing? S e a rC h re S u | tS fo r :
@ || Header | H-04GT_BVRI | 12:01:50.37 -18:53:32.7 || 075.D-0662(B) || FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2005-05-24T03:22:03.371 || May 24 2006 1.998 | B_BESS 53514.140317 1.281 || DIMM Seeing? N G C 4 O 3 8 / I: O R S 2
u @ || Header | H-04GT_BVRI | 12:01:50.37 -18:53:32.7 || 075.D-0662(B) || FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2005-05-24T03:22:44 603 || May 24 2006 0.998 | V_BESS 53514.140794 1.284 || DIMM Seeing?
u @ | Header | H-0O4GT_BVRI | 12:01:50.37 -18:53:32.7 || 075.D-0662(B) || FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2005-05-24T03:22:44 604 || May 24 2006 0.998 | V_BESS 53514.140794 1.284 || DIMM Seeing?
u @ | Header | H-04GT_BVRI | 12:01:50.37 -18:53:32.7 || 075.D-0662(B) || FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2005-05-24T03:23:24.365 || May 24 2006 0.999 | R_SPECIAL || 53514.141254 1.287 || DIMM Seeing?
u @ || Header | H-04GT_BVRI | 12:01:50.37 -18:53:32.7 || 075.D-0662(B) || FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2005-05-24T03:23:24 366 | May 24 2006 0.999 | R_SPECIAL || 53514.141254 1.287 || DIMM Seeing?
u @ | Header | H-0O4GT_BVRI | 12:01:50.37 -18:53:32.7 || 075.D-0662(B) || FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2005-05-24T03:24:03.548 || May 24 2006 2.001 |I_BESS 53514.141708 1.289 || DIMM Seeing?
H @ | Header | H-04GT_BVRI | 12:01:50.37 -18:53:32.7 || 075.D-0662(B) || FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2005-05-24T03:24:03.549 || May 24 2006 2.001 |I_BESS 53514.141708 1.289 | DIMM Seeing?
@®_ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT | IMAGE || FORS2.2011-03-11T01:33:59.998 | Mar 11 2012 179.992 | G_HIGH 55631.065278 1.732 || DIMM Seeing? . . .
@ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T01:33:59.999 || Mar 11 2012 179.992 | G_HIGH 55631.065278 1.732 || DIMM Seeing? g re e n | n d I C ate S p U b | | C |y
@ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T01:38:14.910 | Mar 11 2012 | 699.969 | HEII 55631.068228 1.692 | DIMM Seeing? avai | a b | e d ata
@ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T01:38:14.911 | Mar 11 2012 | 699.969 | HEII 55631.068228 1.692 | DIMM Seeing? \ \
@ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT | IMAGE || FORS2.2011-03-11T01:50:19.122 | Mar 11 2012 || 699.977 | HEII 55631.076610 1.590 | DIMM Seeing? re d | S p rO p r I eta ry
@®_ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T01:50:19.123 | Mar 11 2012 || 699.977 | HEII 55631.076610 1.590 | DIMM Seeing?
@ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T02:02:43.484 |(Mar 11 2012 | 599.971 || OIII 55631.085226 1.501 || DIMM Seeing?
@ | Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T02:02:43.485 |(Mar 11 2012 | 599.971 || OIII 55631.085226 1.501 | DIMM Seeing?
@®_ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE | OBJECT || IMAGE || FORS2.2011-03-11T02:13:07.199 |(Mar 11 2012 || 599.977 || OIII 55631.092444 1.436 | DIMM Seeing?
@ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE | OBJECT || IMAGE || FORS2.2011-03-11T02:13:07.200 | Mar 11 2012 || 599.977 || OIII 55631.092444 1.436 | DIMM Seeing?
@ | Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T02:23:31.143 |(Mar 11 2012 || 599.982 || OIII 55631.099666 1.379 | DIMM Seeing?
@ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T02:23:31.144 |(Mar 11 2012 | 599.982 || OIII 55631.099666 1.379 | DIMM Seeing?
@ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T02:34:24 469 | Mar 11 2012 || 299.995 | R_SPECIAL || 55631.107228 1.326 | DIMM Seeing?
@®_ || Header | NGC4038 12:01:51.59 -18:52:31.8 |[ 086.D-0309(A) | FORS2 SCIENCE || OBJECT || IMAGE || FORS2.2011-03-11T02:34:24 470 | Mar 11 2012 || 299.995 | R_SPECIAL || 55631.107228 1.326 | DIMM Seeing?
Bl & |Header | NGC4o38 12:01:51.59 -18:52:31.8 || 086.D-0309(A) | FORS2 SCIENCE | OBJECT || IMAGE | FORS2.2011-03-11T02:40:14.848 | Mar 112012 | 299.985 |U_HIGH | 55631.111283|  1.300 | DIMM Seeing? ESO/IAU-Opticon Summer School 2015
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JES+ oo R W - ESO Archive Requests download searched files:

O Observatory

¥ ' . o - :' ‘;’ ' : . ESO — Reaching New Heights in Astronomy.

S IEMEICS PSS o -

ESO Home User Portal Contact Site Map

Science User Information > ESO Usear Portal > ESO Archive Requests

ESO User Portal
Data Access Control ~Submit Request

‘ —olo Request Description
Sclence Archive

Archive Requests Media delivery Type How do you want your files to be delivered?
All Requests @ Instant Download

Mailed USB Disk (only for very large requests) i
Recent Requests e ) » A new archive feature
FAQ Options Which files do you want to be delivered? .
Only selected files Wi ” matCh yOUI’ RAW
@ Selected files + associated raw calibrations (if available) science frames Wlth:

Selected files + associated processed calibrations (if available)

- assoclated raw calibrations
Submit Y . associated master calibrations

FORS2.2011-03-11T01:33:59.998
FORS2.2011-03-11T01:33:59.999

FORS2.2011-03-11T01:38:14.910

FORS2.2011-03-11T01:38:14.911

FORS2.2011-03-11T01:50:19.122 _ .
FORS2.2011-03-11T01:50:19.123 For this FORS2 data this means:
FORS2.2011-03-11T02:02:43.484 .

FORS2.2011-03-11T02:02:43.485 - bias

FORS2.2011-03-11T02:13:07.199

FORS2.2011-03-11T02:13:07.200

FORS2.2011-03-11T02:23:31.143

FORS2.2011-03-11T02:23:31.144

FORS2.2011-03-11T02:34:24.469

FORS2.2011-03-11T02:34:24.470

Requested Datasets

NGRH-1_7 2 2® ESO Data Flow Infrastructure
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"z | Welcome to the ESO Science Archive Facility

the raw UKIDSS/WFCAM data obtained at the UK Infrared Telescope facility in Hawaii are available.

The Principal Investigators of successful proposals for time on ESO telescopes have exclusive access to their scientific data for the duration of a proprietary period, normally of one

| The ESO Science Archive Facility contains data from ESO telescopes at La Silla Paranal Observatory, including the APEX submillimeter telescope on Llano de Chajnantor. In addition,

year, after which the data becomes available to the community at large. Please read the ESO Data Access Policy statement for more information, along with the relevant FAQs.

Browsing the archive does not require authentication, but to request and download data you have to log in to the £SO User Porial. Please acknowledge the use of archive data in any

publication.

Latest News and Updates

¢ First release of PESSTO spectral data products (20 Jan 2014)
¢ DSS and Skycat catalogues services migrated (17 Jan 2014)

¢ New data of the VISTA Deep Extragalactic Observations Survey in the VIDEO-XMM field released (17 Jan 2014)

More news ...

To browse the archive
Currently, raw data and various types of data products can be reached via different interfaces:

| Category | QueyForms | Datacollection | Datalype | lInstruments

Raw data query form (all instruments)

;PtORaw Instrument specific query forms All ESO raw data Various Many La Silla Paranal instruments
e Direct retrieval of raw data by file name
it ngs dsoilil Phase 3 Data Products (ESO public Currently, Currently, VISTAIVIRCAM,
ging query surveys, large pregrams, pipeline products, | Imaging and VST/OmegaCAM, UVES pipeline
Phase 3 spectral query form tc 5 e
Phase 3 VIRCAM-specific query form etc.) pectroscopy | products, etc.
Phase 3 Catalogues [ESO User Portal
Catalogue Facility query interface authentication required also when Catalogues Currently, VISTAVIRCAM, FEROS
browsing]
Imaging,
GOODS (C.Cesarsky) Spectroscopy FORS2/ISAAC/VIMOS
zCOSMOS (S.Lilly) Spectroscopy | VIMOS
Advanced Data Products query form Observation of Corot astroseismologically- | Spectroscopy | oo
selected HD stars (E.Poretti) (time series)
Time-domain survey of NGC 2547 e WFI
(S.Aigrain) aging
ROSIMARFES plpeline processed €22 44| FEROSIARPS pipeline processed data | Spectroscopy | FEROS, HARPS
Science Verification, Commissioning, EIS, eic. | Full list of available data packages Various Many
APEX Quick
Look ™ APEX query form APEX Heterodyne, | spEx.24, LABOCA, SABOCA, SHeF!
Broducts e
LPO Scheduling auery form ESO Observing Programme Information All La Silla Paranal instruments, including
Schedule 9 query and Scheduling APEX
ALMA Data =ALMA Science Archive All ALMA data Cube ALMA

The ESO Science Archive Facility was developed in partnership with the Space Telescope — European Coordinating Facility (ST-ECF). It was operated jointly until the & closure of the

ST-ECF in December 2010.
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Archive Usage (an aside)

ESQO archive requests per hour (from Jan. 2011 to present)

1200

o Italian

| Czech

800

600 |-

400+

Number of archive requests per hour

200

- | ‘—\_\—

_| | courtesy of A. Dobrzycki
0 4 8 12 16 | 20 24
local time of requester [hour] ESO/IAU-Opticon Summer School 2015




Conclusions: Archive Value

Archival (re)use of data is/will be a major mode for modern astronomy:

e gives anyone the ability to scrutinize any claimed result ==> the foundation of the scientific method
e data recycling increases its initial value

e allows genuinely new science (e.g. statistically meaningful samples from scattered, multiple
programmes, or time-domain studies.

 allows for fast-track science (submitting observing proposals and getting data takes a long time)
e |owers the access threshold to data (==> a new community of users)

 allows a Pl to assess the feasibility of new observations (preparation for phase 1 and phase?).
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Conclusions: Archive Value

Archive Data Usage
Source: telbib, 1996 - 2012

-—
/ - % . - - - - - - - - - - -
SO - % > S - - - - - - - - - -
'
2 - - S - - - - - - - . [ 3 S r . -
)
)
)
)
! )
: )
) )
-’ . .

L !.---.
1996 1997 1998 1999 2000 2001 2002 2003 2004 2005 2006 2007 2008 2009 20

v

Percentage of papers

source: http://telbib.eso.org

0

[

0 2011 2012 20

ot

3 2014 2015

| B without Archive data usage W Archive data only B Archive plus new data |

An archive publication is defined as a paper in which none of the authors was part of the original proposal
==> a steady 25% of ESO refereed publications since 2012
==> equivalent to one VLT 8.2 m telescope!
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http://telbib.eso.org

: UT3 (Melipal) UT4 (Yepun)
. SPHERE : AOF (2016)
: VISIR ;HAW&(I

By 2016 ESO/Paranal will be offering ~20 VS i
iInstruments to the community émuse

| UT2 (Kueyen)

http://www.eso.org/public/teles-instr/vit/vit-instr/ FLAMES
UVES

UT1 (Antu)

NACO <) i—— Nt " .
CRIRES (2016) /T ( ,
FORS? fir e l
' W ‘ Incoherent
S iy | | 4 : combined focus:

ESPRESSO (2016)

VLTI (2015)

AMBER (2015)
PIONIER (2015)
GRAVITY (2016)
MATISSE (20176)
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Processing Your Data

These instruments are becoming very complex

==> complex data formats (e.g. multi-layered MEF files)

==> complex data dependencies (science <—> calibrations)
==> complex pipelines

Traditionally, the way to process your raw data involves:

* asteep learning curve to become an expert in the instrument
(read a lot of users’/instrument/pipeline manuals).

e write your own scripts to sort, select, and process the data
(IDL, IRAF, python, C++, etc.).

* ~trial-and-error your way to some reasonable results.

There is now a better way . . .

e.g. MUSE: an integral field spectrograph with 24 IFU’s
each of which is sliced into 48 mini slits

ESO/IAU-Opticon Summer School 2015



ESO Reflex makes pipeline recipes accessible
to the general user

each Reftlex workflow has been designed and tested

by instrument & pipeline experts .. L A—
easy to use (do not need to be an expert)

learn the pipeline & instrument by “doing”
(workflows work with tutorial data right out of the box)
visual understanding

Design Goals

- will organize the data for you <MOS Reflex Workflow
- pipeline will run with a single click

- you can monitor the progress of the workflow

- will do the book-keeping for you

- will allow user interaction and modification of pipeline parameters

- allows insertion of User procedures in any language

ESO Reflex is now the recommended environment to run VLT pipeline recipes
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SO Reflex

Reflex is based on the Kepler Worktlow engine

» https://kepler-project.org
 Kepler is freely available under the BSD license.
* used in the life sciences, engineering, climate sciences, ecology, geology, and now in astronomy.

 provides a graphical user interface (Java) to create workflows.

Your Science. Enabled.

> Wy
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*ESJ( SO Reflex
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List of current and future ESO Reflex Workflows:

FORS (imaging, spectroscopy, and MOS)
KMOS

MUSE

SINFONI

UVES

VIMOS (MOS)

XSHOOTER

HAWK-| e
VIMOS (imaging) ==> by the end of 2015
VIRCAM ]
FLAMES-GIRAFFE
VISIR

- ESPRESSO
- SPHERE

- GRAVITY

- MATISSE

All new ESO instruments are required to be delivered with a pipeline & Reflex workflow
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Reflex
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Documentation and links:

Reflex start-up page: http://www.eso.org/sci/software/reflex/
Reflex paper: http://www.eso.org/sci/software/pipelines/documents/reflex_aa.pdf
available workflows & pipeline manuals: http://www.eso.org/sci/software/pipelines/

Installation:

start here: http://www.eso.org/sci/software/pipelines/#installation_instructions

for Linux:

Fedora 20/21/22: — installation rpm’s

all others: — download install_esoreflex script and execute on the command line;
follow the instructions to download and install the workflow of your choice

Mac OS 10.9+: — install using macports

— http://www.eso.org/sci/software/pipelines/installation/macports.html
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Reflex: getting started

O
4

each Reflex workflow installation includes:

e the instrument pipeline &
 a demonstration data set Copgnents
e the Reflex workflow (as an .xml file) —— ‘

e g tutorial manual

Data| Outline

Open X

New Folder Rename File

> [ Compon |/home/mneeser/l(eplerData/workflows/MyWorkflows =
- PFOJ?CFS Folders Files
b [ Statistic

-~ -~

Demos | -/ — kmos.xml
Actors Wi

initialise via the command line:
Datatur| 'eso-demo-workflows/

Director kmos-1.2.6/

b
b
b
b
E fz‘;'reﬂ kmos-1.3.0b1/
b
b
0

Jesoreflex &

Openda = =

Outread
results foun Selection: /home/mneeser/KeplerData/workflows/MyWorkflows

Filter:

ALl Fites |
<:£|Q en
P

@
(@)

ancel

- begins with an empty viewer.
- select <instrument>.xml to initialise
the workflow.

L«

-
b
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Reflex: a summary of the main features

file:/sdp-test_data/mneeser/eso-pipel. . ./reflex/workflows/kmos=1.3.12/kmos.xml

] (=]]E

xﬂ

dow Help

File Edil View Workflow Tools Win

L L=l

[ Components | Data | Outline |

@& K e kIl = =

[ Workflow

DDF Director N
ST KMOS Workflow (v. 1.3.12) E
| ” Search I - —
v Cancel Setup Directories = actor with
|A‘7| anced S | Sources I ance | [ Workflow Instructions [ p Global Parameters interactive option
. In orer to run this workflow: Input: e RacipafailuroMode: Ask
All ontologles and rolders lv DR . . Defines the workflow behaviour for a failing recipe. Fossible values are:
- Turn on highlighting. Choose "Tools™-> "Animate at Runtime' from top menu and set it to "1, © ROOT_DATA_DIR: /sdp_test_datajmneeserfesa-pipelines/kmos/data_gks Ak e cholelto ¢ \ie orstop i leftto Mhe eor
o= Components - Open "Window" -> "Runtime Window" in top menu before starting the workflow if you wish to - - - - el gl it el el B S
" monitor the reduction. & RAW_DATA_DIR: $ROOT NATA_DiUraflex_ nputikmas Cortinue: the emer is gneored and the waorkflow continues
o= PrO]eCtS - Press the "Run” sutton OR cntri-R to start the workflow. - Stop: the workflow stops
o Statisti © CAUB_DATA_DIR: /sdp_test_data/mneeseriesa-pipelines/kmos/instalffaliok... g e oo conee paise
atistics The workflow is initially set to run on a default data set. In order by - P = m— .
o= X to run on a different data set. the following variables have to be set: Working Directories: Y_m:" . l!()()(_Kfll P!N(? ,DIR TMP, PI:H)DI': 35 [,)IR, énd l(y)(:‘u'l]IR
2 Demos - ROOT_DATA_DIR is the root directory containing the workflow related directories defined below each ume the workflow Is run (Lazy Mode won't work anymore)
o= « RAWDATA _DIR contains the RAW data. . - - o FITS VIEWER: qfv
=) Actors - CALIB_DATA_DIR contains the STATIC calibration files (REF_LINES, ARC_LIST, WAVE_BAND, etc...) SBOOKIEERN G RIRSSROOT-DATATDR re flex ook ke 8 plng/kinicia - ) qA i -
o= =5 Dataturbine - BOOKKEE!:ING BIR‘;‘nn:nlnl: varlous Informations about reduction process (asorax cfg fila, SOFs. & LOGS_DIN: $NOOT_DATA_DilVreflex_logakmos o b} [|1P:,-v|n\\-|-| .fi.c'c'f 1[(.- the fles inspection
. parameters used, etc... e GlobalPlothteractivity: True
o~ | | Directors - LOGS_DIR contaiis the esorex 10gs. o TMP_PRODUCTS_DIR: SROOT_DATA_DIR/reflex_tmp_products/kmos Global Interactiity control Point
fl - TMP_PRODUCTS DIR contains the products as they are generated by esorex, slobal Interactimty control Poin
o= |23 Esbo-re ex - FND_PRODUCTS_ DIR cantaing tha ranamead praducts Output: SelectDatasetMethod: Interactive
o [ Jo o vy T e Ty, () (e o, [rvaray s
L JM e © END_PRODUCTS DIR: SROOT DATA DIRireflex end products Data Selection Method (Interactive, All, Complete, Incomplete)
) MyWOrkKriows @ ProwmnanesEaplararfnahled: Tros
ol | Opendap Flag to Enable/Disable the Provenance Explorer
o= [) Outreach
o [E R —
Dat OStep L: . Step 2: Step 3: Step 4: OSt(Ep %
ata Organisation - - - . + - : utpu
g ; Creation of Master Calibration Files Response computation | | Science reduction R
and Selection Organisation
ntialise ( ;’
v
MASTER_DANK
J"il'_I )
( ILLUMINATION L
(SKYFLATS) b |
ny
-
.
I o -
Provenance
Dat. E. L
oumaet ditaset
0 results found.
Auxiliary anc eDug parameters, pease do notchange: o H - - H H I -S\U| ~prn = N 8 B = - o ! B H
[‘_ Auxill dd t d tct GLOBAL_TIMESTAM®: 2015-03-09T10:47:08 @ ESORexArgs: ~suppress-prefix=TRUE ¢ END_PRODUCTS_SUBDIR: 2015-03-09T10:47:06/KM0%.2013-06-30T23:48:06.049_tpl @ N_SELECTED_DATASETS: 1 _)|
J'
[ -
=
o [T
L | _J
*l n
_— — =
d W Il >
executing. |

e.g. the KMOS Reflex Workflow

e to run the demonstration
data set just click start: B>

e to run the workflow on
your own data follow
the instructions
to change the setup
directories

high-lighted Actor
shows where in the
workflow you are

indicates an Actor
with an interactive
option
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Reflex: a summary of the main features

O

+

e DataOrganiser

DOF Diractor

- organises all input data (science & calibrations) into groups (datasets) @ KMOS Workflow (v. 1.3.0b1)
that can be processed independently by the workflow.

Workflow Instructions Setup Directories

Each dataset has a tree structure and represents the complete calibration —
casca d e. before starting the workfiow if you wish to :ZT\" [\:::A:: mva;c;:; mlsnnm:osh:e WDINidata_ ki
The datasets are organised, classified, and associated using the data headers gmmammmaL., T Working Divsctores: e
==> any science frame will be optimally matched to its required NG PRSUCTS B conais the rnemed o T  output ot e
calibration frames (e.g. for KMOS it will: e
DIT-matched darks, arc lamps, flats, ArNe Step 1: ren 2 . Srep 4. Step 5:

Data Organisation

line lists, illumination correction flats, telluric standard stars, and Selection Creztion of Masber CallbratlonFles Response computation | [science reduction || 5 PERC o,
atmospheric models, spectral type look-up tables, etc.) e

4
anise = : ; 1
‘ [ =) ILLUMINATION
: 1 v [SKYFLATS)
talSet Seleftion
v / - , A £ J

e
urrgn ASREE

Data,Set Selecion

inge: o GLOBAL_TIMESTAMP: 2014-03-05T11:38:34 e ESORexirgs: ~suppress-prefu=TRUE @ END_PROOUCTS _SUBDIR: 2014-03-05T11:38:34/KMO0S.2013-06-30723:48:06.049 tp o N _SELECTED DATASETS: 1

e DataSetSelection

- will list all unique data sets found by the DataOrganiser and allow the
user to select which ones to process.
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0 ESO Reflex: a summary of the main features
+

then, the pipeline processing begins:

KMOS Workflow (v. 1.3.0b1)
e Master Dark

. Workflow Instructions Setup Directories Global Parameters - =;:1(lte':;:.5’;option
- the DIT-matched raw darks are processed into : f——
master dark frames and hot pixel masks.

ghting. Choose "Tools"-> "Animate at Runtime” from top menu and set it to "1°.
- t b

y . © ROOT_DATA_DIR: /scratchimneeser/SDP/KMOS/insta Wbin/data_wkf/
W -> “Runtime Window" in top menu before starting the workflow if you wish to

© RAW_DATA_DIR: $ROOT_DATA_DIRfreflex input/kmos

MASTER_DARK

© CAUB_DATA_DIR: fscratchimneeser/SDP/KMOS/insta Wbinfnstallicalibikmos-

[ Working Directories:

ables have to be set:
ng the workflow related directories defined below

the STATIC calibration files (REF_LINES, ARC_LIST, WACE_BAND, etc...) ©BOOKKEEPING_DIR: SROOT_DATA_DiRfreflex book_keeping/kmos
ins various Informations about reduction process (esorex cfg file, SOFs, ©LOGS_DIR: $ROOT DATA_DIR/refiex logs/kmos

x logs o TMP_PRODUCTS_DIR: $ROOT_DATA DiRfreflex trmp_products/xmos
the products as thay are generated by esorex.

ntains the renamed products Output: ® SelectDatasetMethad: Interactive

ata Selection Method (Interactive, All, Complete, ncomplete
© END_PROOUCTS_DIR: SROOT_DATA_DIRireflex_end_products Data St n Method (Interactive, All, Complete, incomplet

Pl Step 2: Step 3: Step 4: Step 5:
aaisation Creation of Master Calibration Files Response computation | |Science reduction Output
ana >election T Organisation

o ,
for] organiser

Pl

e Lamp Flat

- the filter-matched lamp flats are processed
into master flat frames and cold pixel masks.

LAMP_FLAT

* Wavelength Calibration
- a wavelength solution is found for the filter-
matched arc frames, which are then processed
into reconstructed arc line frames and a
wavelength solution look-up frame.

—
4
niu-

hange: o GLOBAL_TIMESTAMP: 2014-03-D5T11:38:34 @ ESORexirgs: ~suppress-prefi=TRUE ®END_PROOUCTS_SUBDIR: 2014-03-05T11:36:34/KM0S5.2013-06-30723:48:06.049 tp oN_SELECTED_DATASETS: 1 |
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Reflex: a summary of the main features
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Interactive Actors mE

PO+ - BE
e Wavelength Calibration Reclpe Parameters

Wavelength Calibration ‘

Extension Nb 7 Extension Nb 9

- reveals reconstructed arc lamp frames for % e 2000 order [ o)
each detector and can be selected for ook e nit s e g .
. . . 1500 1500 suppress_extension [ false’
each of the six calibration rotator angles SRR A [ 2008
(OO, 600, 1200, 1809°, 240°, and SOOO) 1000 s “' 1000 ) [ |
_—— b_start -1
500 oatties 500 b_end [ -1’
mouse-over reveals pipeline 0= .
QC keyword Va|UeS 20040060080a.000200400 ‘ ‘
Re-run Recipe
ESO QC ARC AR POS MEAN: -0.620317 [ Hele |
ESO QC ARC AR FWHM MEAN: 1.867742 0 !I)isable this window
ESO QC ARC NE POS MEAN:  0.313877 njsbscquentnns
ESO QC ARC NE FWHM MEAN: 1.823414 i i This data belongs to dataset:
Angles selection > ! Al'gon! Lines ! KMO0S.2013-06-30T23:48:06.049 _tpl
o HH H H +H H H H}
O eo ) I SN 0 SN S S S S S
L _ . . 20 40 5 10 5 20
Modifiable pipeline parameters () 1000 . | Neon Lines |
L (O 2¢00 - 0 0 1 1 1
can be changed and re-run in pipeline to 0 00 m_%[ { { [ { } H [ } H -
Optimiseresu”s_ §_2 e e e T e e e
30 5 10 15 20

File Extensions 1 -> 18

x=333.207 y=1183.55 value=27.8162
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Reflex: a summary of the main features

O

+

Reflex Interactive App ‘;| |E‘ |X|

the processing continues: fa + - B

Recipe Parameters

Recons. | Extr. Comb. Star

Standard Stars Selection Median collapsed cube (STD_IMAGE)

14
imethod [ cs|
12
xcal_interpolation [ TRUE}
. FU-3.DATA 0 b samples [ 20481
® [llumination Correction . il
- filter-matched sky flats are used to compute an AT [ 10|
illumination correction for each IFU. () ruz.0mm ° 5 | 10|
PR R
2
‘Continue ka’
‘Re-run Recipe’
‘ Help ’
= Extracted Standard Star Spect (STAR_SPEC) \ \ \
o Te"urlc Standard Star ! “s il !ar o ; T 0 !Dlsatz)le this V\élndOW
. . : : : : : IN supsequent nuns
_ f'lter'matChed Standard Stal’ flelds processed 140000} S o o o o .
into a median cube-collapsed image and an wooool g g LN, ] Wil i el e et

KMOS.2013-06-30T23:48:06.049 _tpl
extracted spectrum.

100000 | -

Flux (ADU)
3 3
o =)
o o
o o

2.1 2.2
Wavelength (microns)
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Reflex: a summary of the main features

O

+

Reflex Interactive App — 18] X

the processing continues: @ + B@E =

Recipe Parameters

Files Selection (Mouse left button) Recons. | Extr. Comb. Other
sci_reconstructed_KMOS.2013-07-01T00:46:26.588 fits ‘
: i imethod | CS‘
sci_reconstructed_KMOS.2013-07-01T00:09:35.560 fits
. . sci_reconstructed_KMO0S.2013-07-01T00:25:24.507 fits ) )
e Science Reduction sci_reconstructed_KMOS.2013-06-30T23:48-06.049 fits xcal_interpolation | TRUE|
. . sci_reconstructed_KMOS.2013-07-01T00:30:37.274 fits
- science frames are flat-fielded, wavelength sci_reconstructed_KMOS.2013-06-30T23:59:09.586 fits b_samples | 2048
calibrated, illumination corrected (optional), flux- sci_reconstructed KMOS.2013-07-01T00:41:13.785.fits
. . . sci_reconstructed_KMOS.2013-07-01T00:20:10.285 fits b_start | -1.0 ‘
calibrated (optional), reconstructed and combined. sci_reconstructed_KMOS.2013-07-01T00:04:22.390.fits
b_end | -1.0|

|[FUs Selection (Mouse middle button)

e TTTE LB LT EEEEEET: e e

Help

SOF SCI RED

L 4 — Disable this window
in subsequent runs

Spectrum This data belongs to dataset:
1200 : : ' ' ' KMO0S.2013-06-30T23:48:06.049_tpl

1000

MIE

SCI_RED

800 -

600

Flux (ADU)

400

200 |

A PP L Al 1 . P A Lo i ) A i i
0
2.0 2.1 2.2 2.3 2.4
Wavelength (microns)
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Reflex: a summary of the main features

e Product Provenance

- the Reflex workflow finishes with a
product provenance window in which
all pipeline products can be tracked
to the raw & calibration frames that
were used in their creation.

b4

v Product Provenance
Search products Provenance Tree Category Keyword Value
¢ [ sci_reconstructed_KMOS.2013-07-01T00:25:24.507.fits SCI_RECONSTRU4||SIMPLE T =
“Last |Hour |= [ KM0S.2013-06-30T23:48:06.049.fits SCIENCE BITPIX 8 =
O All [} kmos_wave_band.fits WAVE_BAND NAXIS 0
® From 121113 105118 | ¢ % KMOS.2013-07-01T00:30:37.274.fits SCIENCE s T
KMOS.2013-07-01T00:09: 35.560.fits SCIENCE .
To  [1211/1311:37:33 |gg [} KM0S.2013-07-01T00:04:22.390.fits SCIENCE ?é,fscop Egé?VSTG_S{TOMS"'
Search [} KM0S.2013-07-01T00: 35:55.867.fits SCIENCE INSTRUME KMOS
[} KM0S.201 3-07-01T00:46:26.588.fits SCIENCE _|oBECT WAVE, LAMP
Sl Date | [} KM0S.2013-06-30T23:53:23.571.fits SCIENCE ~|RA 164.493074
¢ [ KMOS.2013-06-30T23:48:06.049_tpl 2013-11-12T11:37:1[4| [ K05.2013-07-01700:20:10.285.fits o gESINOX '22046250103
[} SCI-GUMA3 MAKE_IMAGE. 16.fits [ KM0S.2013-07-01T00:14:52.379 fits SCIENCE REDECSYS 2
[ SCI-GUM43_SCI_COMBINED_7.fits 4 [ KM0s.2013-07-01T00:41:13.785fts SCIENCE eI 3 5600050
[} SCI-GUM43_EXP_MASK_2.fits [ K05.2013-07-01T00:25:24.507.fits LSS MJD-OBS 56470.11681253
[} SCI-GUM43_SCI_RECONSTRUCTED_5.fits | [) kM0S.2013-06-30T23:59:09.586.fits SCIENCE DATE-0BS 2013-06-27T02:48...
D SCI-GUM42 MAKE IMAGE 6.fits o [ master_flat_KKK fits MASTER_FLAT UTC 10092.000
[ SCI-GUM43_SCI RECONSTRUCTED. 8. fits o (9 star_spec_KKK fits STAR_SPEC LST 59287.265
[} SCI-GUM43_SCI_COMBINED 1 fits o (=] illum_corr_KkK fits ILLUM_CORR PlLcol KON
[} SCI-GUM43_SCI_RECONSTRUCTED_4.fits ¢ [ lcal KiKfits LCAL OBSERVER e sl ~
[ SCI-GUM43_SCI RECONSTRUCTED 3.fits [ KMO0S.2013-06-27T02:48:12.603.fits ARC_ON ORISFILE KMOS SPEC CALL7...
_SCL_ 3. : HIERARCH.ESO.ADA.A... |120.00001
[ SCI-GUM43_SCI_COMBINED_S.fits [ kmos_wave _band.fits WAVE_ HARD HIERARCH.ESO.ADA.A... |NEG
[} SCI-GUM43_MAKE_IMAGE_17.fits [ K05.2013-06-27702:46:24.832 fits ARG DN HIERARCH.ESO.ADA.A... [119.99912
[} SCI-GUM43_EXP_MASK_15.fits [ KM0S.2013-06-27T02:47:18.086.fits ARC_ON HIERARCH.ESO.ADA.G... |OFF
[ SCI-GUMA3_MAKE IMAGE. 18.fits [} KM0S.201 3-06-27T02:50:01.906.fits ARC_ON HIERARCH.ESO.ADA.P... |0.00000
[ SCI-GUM43_SCI RECONSTRUCTED 1.fits [} KM0S.2013-06-27T02:49:06.959.fits ARC_ON HERARCHESODETA.. |E
[ SCI-GUM43_EXP_MASK 6 fits e Q injfi‘f:‘-nneilftn‘lf—fff remamae g {\TE‘E-S-T ~|HIERARCH.ESO.DET.A... |ngciracqH2RG4 -m... |—
4 I I” I I >l 4 | ”l I I ’I WICDADCL] CC NDCT A | = b
Inspect
Continue
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Reflex: a summary of the main features

O
<+

Results and Products:

® all pipeline products, book-keeping, and pipeline logs are saved to the directories specified in the setup directories.
® cach run through the workflow with differing inputs will be saved in a directory with a different time-stamp.
® | azy Mode (on: calibrations from previous runs are re-used; off: calibrations are recreated).

® |nteractive actors can be turned off for batch-mode execution of the pipeline.
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SO Reflex: a summary of the main features

What if you want to add your own procedures to an existing Reflex workflow?

® it is possible to add your own scripts to the Reflex workflow . . . additional pipeline recipes, your own
C routine, IDL script, or, easiest of all a Python routine.

® c.g. execute generic python code:

® translate from/to Reflex ports to/from python script arguments a special syntax is used, with the help of
an exisiting python module:

In an open Reflex worktlow, select from the components menu:
ESO-reflex —> Scripting.kar—> PythonActor
(I will give a demonstration of this in the next session)

For more detalls see:

Reflex Workflow Development Guide:  ftp://ftp.eso.org/pub/dfs/reflex/reflex_dev_guide-1.0.pdf
Reflex User Manual: ftp://ftp.eso.org/pub/dfs/reflex/ReflexUserManual-3.5. pdf
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Part 1: In Theory

Getting Data from ESO:
- the contents of the ESO Science Archive Facility (SAF)
-+ how to access the archive for high-level science data or for raw data

Using Data from ESO:
- Reflex workflows and ESQO pipelines
- Reflex workflow basics
- Installing Reflex
- a summary of the main features of Reflex

Part 2: In Practise

A Practical Demonstration of:

- retrieving raw data from the ESO archive

- retrieving science products from the ESO archive
- running the HAWK-| Reflex workflow
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+ European ol A ., ! ' g 1 ,‘ -
+ES* sauver i - ; - e N
O Observatory ; * 4 I v , 74 — eaching New Heights in Astronomy
+ : . ccam RSl amslSsom—-H3 o= =
Public Sclence User Portal Intranet Site Map Search
Science Users Information > Science Archive Faclity > Data Portal 30 Jul 2015
Sclence Archive Faclility

Data Portal

archive.eso.org

User Portal Login The ESO Science Archive Facility contains data from ESO telescopes at La Silla Paranal Observatory, including the APEX submillimeter telescope on Llano de Chajnantor. In addition,
Data Access Control the raw UKIDSS/WFCAM data obtained at the UK Infrared Telescope facility in Hawaii are available.

ESO Data The Principal Investigators of successful proposals for time on ESO telescopes have exclusive access to their scientific data for the duration of a proprietary period, normally of one
Hubble Space Telescope Data year, after which the data becomes available to the community at large. Please read the ESO Data Access Policy statement for more information, along with the relevant FAQs.

Virtual Observatory Tools Browsing the archive does not require authentication, but to request and download data you have to log in to the ESO User Portal. Please acknowledge the use of archive data in any

Latest News and Updates

News and Updates

o New Release of Gaia-ESO Spectroscopic Public Survey Data (22 Jul 2015)
calibr rv inetrum W i Arc 45
ESO Data s Policy ¢ Processed calibration files for VLT instruments now available in ESO Archive (20 Jul 2015)

More news ...

To browse the archive

Currently, raw data and various types of data products can be reached via different interfaces:

Access Point

Raw data query form (all instruments)

o New user guide describing the reduced data products accessible via the ESO Science Archive Facility published (18 May 2015)

'[szg Raw Instrument specific query forms All ESO raw data Various Many La Silla Paranal instruments
i Direct retrieval of raw data by file name
Various
Phase 3 main query form Phase 3 Data Products (ESO public Currentl
Phase 3 imaging query form surveys; ESO pipeline-reduced products; T yénd Pipeline products for UVES,
Phase 3 spectral query form Large programs: GOODS, zCOSMOS; Spe%ugscopy XSHOOTER, HARPS, and more to
[Description Phase 3 VIRCAM-specific query form etc.) come.
of reduced
data
products Phase 3 Catalogues [ESO User Portal
Catalogue Facility query interface authentication required also when Catalogues Various
types] .
browsing]
: : ; L FEROS, HARPS-Polarimetry, HARPS
FEROS and HARPS-Polarimetry pipeline FEROS and HARPS-Polarimetry pipeline Kbl :
processed data query form processed data SpeciroRcopy r;: :::: a.f (I)l‘l,)gtlons (o pac
et Spectroscopy | FEROS
Other Advanced Data Products (available only . .
as downloadable packages, no query form) Various (30 Doradus, Corot, GaBoDs, etc.) g::‘axgmgps XVF':IIEX
Science Verification, Commissioning, EIS, etc. = = )
(no query form) Full list of available data packages Various Many
APEX query form APEX Peerodyne: | APEX-2A, LABOCA, SABOCA, SHeF!
- ESO Observing Programme Information All La Silla Paranal instruments, includin:
et and Scheduling ’ APEX ’
B ALMA Science Archive All ALMA data Cube ALMA
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A Demonstration of the HAWK-| Reflex Workflow

® OO file:/opt/local/share/reflex/workflows /hawki-0.9.2 /my_hawki-casu_0.9.2.xml

N T IR e ==
Data = Outline | N

DDF Director

~Search Components ()] Hawk-I Test Workflow (v. 0.95)
7, N
Q | Search
i H H = actor with
‘ Advanced ... ‘ Sources ‘ Cancel Workflow Instructions Setup Directories Global Parameters - interactive option
To run this workflow on the demo data: Input: 'G/\Io‘?al Earan:eter f<t).r the behtawou}l'l\;hen a rect|pde fails.
H A 0 ROOT_DATA_DIR: /Volumes/SDP7 ) ) ) sk’ choice to continue or stop will be presente
‘ All Ontologies and Folders ) - Turn on highlighting. Choose "Tools"-> "Animate at Runtime" 0 RAWDATA_DIR: SROOT_DATA_DIR/RAW @ ReclpefailureMode: Ask ,g""‘,‘_”“e :k"f‘iorkf"?l‘;v will ignore errors and continue
> C f';om wPF: m;nu a;d set ié):(o "1"i R 5 1 o CALIB_DATA_DIR: //Users/mneeser/WORK/SDP/UK_in-kind /pipelines/Reflex_HAWK... top:: workHow will stop.
- Press the "Run" button cntrl-R to start the workflow.
Omponents © SCHLEGEL_MAPS_DIR: SCALIB_DATA_DIR o EraseDirs: false ‘true’: BOOKKEEPING_DIR, TMP_PRODUCTS_DIR and LOGS_DIR
> Projects To run on a different data set: © TWOMASS_CATALOGUE_DIR: /Users/mneeser/WORK/SDP /UK _in-kind /pipelines/STD_catalogu... directories erased at start of workflow; Lazy mode will not work
- Click on ROOT_DATA_DIR and set as appropriate. © PPMXL_CATALOGUE_DIR:
[ Statistics All subdirectories of RAWDATA_DIR will be searched for data. © LOCAL_CATALOGUE_DIR: © FITS_VIEWER: fv name of local fits viewer/editor application to inspect files
= - If desired, change END_PRODUCTS_DIR. T Joff int tive GUIs f Il sub fl
- Press the "Run" button OR cntrl-R to start the workflow. ; ; ace ivity: urn on/oft interactive GLUIs tor all subworkrows
» || Demos Working Directories: . @ GlobalPlotinteractivity: true  \p. Faple Interactivity inside subworkflows have precedence
> | | Actors To monitor the progress of the workflow in more detail: © BOOKKEEPING_DIR: SROOT_DATA_DIR/reflex_book_keeping @ ProvenanceExplorerEnabled: true  Show Provenance Explorer Window
— - Open "er;Idow" ;(;l "Runtime Window" in top menu before 0 LOGS_DIR: SROOT_DATA_DIR /reflex_logs o SelectDatasetMethod: Interactive
: starting the wor! ow. )
b | | Dataturbine 9 © TMP_PRODUCTS_DIR: SROOT_DATA_DIR /reflex_tmp_products ‘ )
Select catalog on local machine if not using CDS
} l_' DII’eCtOFS OUtpuc © ASTROM CATALOGUE: 0 0: 2MASS
. - ) 1: PPMXL
I> ‘_1 ESO-reﬂex @ END_PRODUCTS_DIR: SROOT_DATA_DIR /reflex_end_products © PHOTOM_CATALOGUE: 0 2. | OCAL
> | | Job
» || Opendap Step 1: Step 2: Step 3: Step 4:
» [ Outreach Data Organisation Crea'mon.of Master . Standard Star and ‘ Output
. \— N and Selection Calibration Files Science Images Reduction Organisation
|

Initialis
I 4
“-L\ i
DatgOrganizer

1=

~—
i)

ess

Da t Selection

0 results found.

Initi urrent Dataset

ctRenamer

CatalogueSelector

<

ProvenanceExplorer

( Auxilliary and debug parameters, please do not change © GLOBAL_TIMESTAMP: 2015-09-01T15:17:59 @ ESORexArgs: --suppress-prefix=TRUE @ END_PRODUCTS_SUBDIR: 2014-06-24T15:21:15/HAWKI.2008-11-18T00:22:15.321_tpl o N_SELECTED_DATASETS: 2 )
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